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TRAVAUX PRATIQUES 
Synthèses inorganiques, capteurs 

électrochimiques, cristallographie, logiciels 
 
 
 

Ce fascicule présente des manipulations pouvant être associées aux leçons suivantes : 
 

• LC 17 Solides cristallins (CPGE)  

• LC 6 Chimie analytique quantitative et fiabilité (Lycée) 

• LC19 Application du premier principe de la thermodynamique à la réaction chimique 
(CPGE) 

• (LC 27 Solubilité) (CPGE)  

• (LC 23 Diagrammes potentiel-pH) (CPGE)  

 

Expériences 
 
Seule l’expérience I.A ou I.B sera réalisée. 

 

I- SYNTHESE DE COMPLEXES 
 
  I.A Synthèse du sulfate de tétraamminecuivre (II) hydraté [Cu(NH3)4]SO4, H2O 

  I.B Equilibres entre deux complexes de cobalt (Fosset p 202) 

 

II- HYDROMETALLURGIE DU ZINC (BUP 770 P 79) 
 
 

III- UTILISATION DE LOGICIELS 
 
   III.A – Cristallographie 
  III.B – Dosages : utilisation de dozzzaqueux et Chimgéné 
  III.C – Tracé d’un diagramme potentiel-pH 
   III.D – Traitement d’incertitudes : Utilisation du logiciel GUM-MC 

École Normale Supérieure de Lyon Année 2020-2021 
Préparation à l’Agrégation de Physique  Fogeron Thibault 
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Protocoles 

 

I.A. Synthèse du sulfate de tétraamminecuivre (II) hydraté 
[Cu(NH3)4]SO4, H2O  
 
En phase aqueuse, l’addition d’une solution d’ammoniac sur une solution de sulfate de cuivre 
conduit à la formation d’un complexe : l’ion tétraamminecuivre (II) [Cu(NH3)4]2+. Il précipite en 
présence des ions sulfate SO42− et peut ensuite être isolé par filtration.  
 
Protocole expérimental : 
 
1. Dans un erlenmeyer, dissoudre 2,5 g de sulfate de cuivre pentahydraté CuSO4, 5 H2O dans 10mL 
d’eau distillée. 
 
2. Ajouter ensuite, sous la hotte et en agitant, 25 mL d’une solution d’ammoniac à 2 mol·L−1 jusqu’à 
disparition totale du précipité d’hydroxyde de cuivre (II) formé au début de l’addition d’ammoniac. 
 
3. Refroidir la solution dans un bain eau-glace, puis ajouter 15 mL d’éthanol à 90° : un précipité se 
forme lentement. 
 
4. Laisser refroidir le mélange dans un bain eau-glace. 
 
5. Lorsque les cristaux sont formés, filtrer le mélange sur un filtre Buchner puis laver les cristaux 
avec 5 mL d’éther diéthylique. À partir du solide synthétisé, une solution aqueuse, couleur bleu 
nuit, de complexe tétraamminecuivre (II) à la concentration C � 20 mmol. L�� est préparée. On 
trace le spectre d’absorption du complexe : 
 

 

Figure 1 : Spectre du complexe synthétisé 

 
Questions 
 
1. Écrire l’équation de la réaction mise en jeu. 
 
2. Calculer les quantités de matières des réactifs introduits. Construire un tableau d’avancement. 
Quel est le réactif limitant ? 
 
3. Exprimer, puis calculer le rendement de cette synthèse. 
 
4. Quel est le rôle de l’ajout d’éthanol ? Pourquoi utilise-t-on un bain eau-glace ? 
 

5. Quels sont les avantages d’une filtration Buchner sous pression réduite par rapport à une 
filtration simple ? 
 
6. Décrire le protocole expérimental permettant de préparer une solution aqueuse homogène à 
partir du solide précédemment synthétisé. 
 
7. Décrire le protocole expérimental permettant de tracer le spectre ci-dessus. 
 
8. La couleur du complexe obtenu est-elle cohérente avec l’allure du spectre d’absorption ? 
 
Données : 
 
-  Masses molaires en g. mol�1 : 

M�Cu� �  63,5 ;  M�H� �  1,0  ;  M�O� �  16 ;  M�S� �  32,1 ;  M�N� �  14 
 
-  Couleurs complémentaires : 

 
 
Remarques On peut utiliser ce complexe pour l’analyse de la teneur en nitrate d’une eau 
(http://www.jeulin.fr/Documents_Public/Jeulin/ECE/PC/ECE_19_PC_61.pdf). Vous pouvez donc 
aller plus loin que ce qui est fait ici. L’expérience dure 1h et demande de faire une gamme étalon 
mais est très complète. 

I.B  Equilibres entre deux complexes de cobalt 

 

En milieu chlorure les ions cobalt peuvent existés sous deux formes : un complexe hydraté de 
géométrie octaédrique �Co�H�O� !�" et un complexe tétrahédrique �Co�Cl�#!�� qui sont en 
équilibre en solution. Les deux complexes sont de couleurs différentes (respectivement bleue et 
rose en solution) ce qui permet d’identifier facilement la forme prépondérante.   

La réaction de déshydratation étant endothermique (∆%H& �  92.7 kJ. mol��� elle est favorisée 
à température élevée et on a donc un changement de couleur de la solution en fonction de la 
température.  

 

�Co�H�O� !�" + 4 Cl� ⇄  �Co�Cl�#!�� + 6 H�O 

 

Protocole :  

 

Attention : Le chlorure de cobalt est un CMR : prendre les mesures de sécurité expérimentales 
associées (gants, lunettes). 
 

- Dans un erlenmeyer de 100 mL introduire :  

- 10 mL d’eau 
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- 40 mL d’acétone 

- 1,19 g de chlorure de cobalt hexahydraté  

 

- Répartir cette solution dans 3 tubes a essais. Plonger un tube dans la glace, un autre dans un bain 
marie d’eau chaude à environ 70 °C et laisser le dernier à température ambiante. 

 

- Comparer les couleurs des trois solutions.  

 

Bonus : On peut enregistrer mes spectres UV-Vis des trois solutions entre 400 et 800 nm pour être 
un peu plus quantitatif. Il faut alors porcéder suffisament rapidement pour éviter un retour des 
solutions à température ambiante lors de la mesure.  
 
Questions 
 

1. Au vu, de l’enthalpie de réaction de la réaction de déshydratation décrivez l’évolution de la 
constante de réaction en fonction de la température.  

 

2. A quelle transition est du la couleur des solutions ? 

 

3. Expliquer alors la différence de couleurs entre les deux complexes en solution. 

 

 

 

 

 

  

II  Hydrométallurgie du Zinc  
 

Le zinc se place aujourd’hui au troisième rang des métaux non ferreux. Matériau ancien, le minerai 
de fer a longtemps contribué à la fabrication d’alliages de bronze et de laiton, avant d’être employé 
pour ses propriétés protectrices, puis ensuite dans la réalisation de toitures, gouttières et mobilier 
urbain. Avec le développement de l’automobile, il a été utilisé après guerre pour la galvanisation 
des carrosseries. Aujourd’hui, l’industrialisation du monde moderne a favorisé l’augmentation de 
la consommation en zinc (transport, infrastructure, bâtiment, équipement industriel), grandement 
apprécié pour ses propriétés chimiques, notamment son caractère fortement réducteur. 

 

Le zinc est extrait sous formé de sulfure (ZnS), il subit ensuite une étape de grillage pour l’obtenir 
sous forme d’oxyde (ZnO). Dans la grande majorité des cas (90 %) le zinc pur est obtenu par 
hydrométallurgie à partir du minerais oxydé. Ce sont ces étapes qui vont être réalisées dans la 
suite.  

 

Pour des compléments beaucoup plus précis sur les procédés industriels, et des informations de 
culture général je vous conseil de regarder l’élémentarium (version mise à jour du BUP dont est 
issu l’expérience) https://www.lelementarium.fr/ (site très utile pour toute donnée industrielle), 
ainsi que le technique de l’ingénieur M2270 v2.  

 

Par rapport au BUP, le protocole est légéremment modifié pour faciliter certaines étapes et pour 
des raisons de sécurité.  

 

II.1 Lixiviation acide 

 
Nous allons ici réalisée la lixiviation d’un « minerai » de calcine riche en fer (les minerais contenant 
peu de fer sont plus solubles et ne nécessitent pas un traitement aussi acide).  

 

La calcine va être reconstituée en ajoutant les quantités suivantes à un erlenmeyer de 250 mL :  

ZnO : 5g 

Fe2(SO4)3,6 H2O : 4,5 g (remplace l’oxyde de fer très peu soluble dans ces conditions) 

CuO : 1 g (peut être remplacer par du sulfate de cuivre car la solubilité de l’oxyde de cuivre reste 
faible) 

Sable de fontainebleau : 200 mg (optionnel) 

 

On ajoute enivron 40 mL de H2SO4 à 2 mol/L. L’ensemble est agité. On peut noter l’élévation de 
température (jusqu’à 60°C). La suspension est chauffé environ 5 min à 100 °C, puis on laisse à 
décanter 2 minutes. Le surnageant est alors filtré sur papier filtre. La silice (ici sous forme de 
sable), ainsi que le zinc et le fer inclus dans la ferrite sont éliminés. La solution a la couleur bleue-
verte principalement due aux ions de Cu (II).  

 

La présence, dans la solution, des ions fer (III) peut être mise en évidence, à l’aide d’ions 
thiocyanate (formation d’un complexe rouge). Pour cela prelever environ 0,5 mL de la solution et 
les mettre dans un tube un essai. Ajouter alors quelques gouttes d’une solution de thiocyanate de 
potassium.   
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II.2 Précipitation du fer 
 

A la solution obtenue après lixiviation, on ajoute environ 150 mL d’eau puis 3,5 g de sulfate 
d’ammonium et, on chauffe la solution pour tout dissoudre. 

Refroidir la solution à l’aide d’un bain de glace pour revenir à t.a.  

En mesurant le pH, ajouter de la soude concentrée jusqu’à pH �  4,5 � 5. (industriellement, 
l’augmentation de pH est réalisée par ajout de calcine, c’est possible de la faire ici par jout de ZnO 
(au moins 3 g) mais on ajoute alors des insolubles à une solution déjà difficile à filtrer). Dans tous 
les cas, il ne faut pas dépasser un pH de 5 afin d’éviter la précipitation de l’hydroxyde de zinc. Sinon, 
ajouter de l’acide sulfurique 2 mol/L pour maintenir le pH à la bonne valeur. Un précipité brun-
rouge de jarosite apparaît.  

 

Filtrer alors sur Büchner. La filtration est difficile, procéder par ajout de petits volumes et changer 
de filtre si besoin. Après filtration, la jarosite est éliminée, la solution obtenue est bleue. Prelever 
environ 0,5 mL de la solution et les mettre dans un tube un essai. Ajouter alors quelques gouttes 
d’une solution de thiocyanate de potassium. Comparer alors la couleur avec le tube précédent et 
conclure sur l’efficicacité de la précipitation du fer.    

 

II.3 Cémentation : élimination du cuivre 

 
La présence des ions Cu2+, caractérisée par la couleur bleue de la solution peut également être mise 
en évidence, dans un tube à essais, à l’aide d’ions I� . Sur un prélèvement de quelques ml de 
solution, verser quelques gouttes de solution de KI. La réaction suivante à lieu :  

 

2 Cu�" + 4 I– → 2 CuI +  I�  

 

La présence de Cu  est caractérisée par l’apparition de la couleur brune du diiode (qui en 
présence d’empois d’amidon donne une coloration bleue) et la formation d’un précipité blanc 
d’iodure decuivre (I), CuI qui en présence du diiode et des ions Cu2+, apparaît vert-jaune. Pour 
mettre en évidence la présence des ions Cu2+, on peut aussi ajouter, au prélèvement de solution, 
quelques gouttes de solution concentrée de NH3. Il se formera simultanément un précipité blanc 
de Zn(OH)2 et un précipité bleu de Cu(OH)2, ce dernier étant soluble dans un excès de NH3 
concentré en donnant un complexe bleu, caractéristi-que des ions Cu2+ (cf. mabipulation I.A) . 

 

 Après élimination des ions fer (III), ajouter environ 0,3 g de zinc en poudre. Après quelques 
secondes d’agitation, filtrer. La coloration bleue de la solution disparaît. Les tests précédents 
montrent l’absence des ions Cu2+. 

 

II.4 Électrcolyse : obtention du Zinc pur 
 

Avant électrolyse, la présence, dans la solution, des ions Zn2+ peut être mise en évidence, sur un 
prélèvement dans un tube à essais, en ajoutant une solution diluée de NaOH. Il se formera un 
précipité de Zn(OH)2, blanc, soluble, par formation d’un ion complexe, dans un excès de NaOH. 
L’électrolyse de la solution purifiée est réalisée entre une cathode en aluminium et une anode en 
plomb selon le schéma représenté sur la Figure 2. Peser la cathode avant l’électrolyse. On choisira 
un courant de fonctionnement de environ 200 mA.  

 

 

Figure 2 : Électrolyse de la solution de Zn2+. 

On observe un dégagement gazeux à l’anode (dioxygène) et le dépôt de zinc à la cathode. Ce dernier 
est difficilement visible en cours d’électrolyse. Il faut plusieurs dizaines de minutes pour constater 
visuellement la formation de ce dépôt. Après électrolyse, qui pour augmenter la quantité de zinc 
déposé peut durer plusieurs heures, rincer l’électrode à l’eau puis à l’acétone. Après séchage rapide 
dans une étuve, le zinc formé peut être pesé.  
 
Rq : Après électrolyse, la solution peut être recyclée en début d’expérience pour dissoudre la 
calcine. Un ajout de solution d’acide sulfurique, 2 mol/L, sera peut-être nécessaire pour obtenir 
une solution de dissolution possédant un pH de départ adéquat (0,5 à 1). 
 
Questions 
 
1. A l’aide du diagramme E-pH expliquer l’intérêt de se mettre en milieu acide pour la dissolution 
de la calcine.  
 
2. A l’aide du diagramme E-pH expliquer pourquoi on se place à pH = 4,5 pour la précipitation du 
fer. 
 
3. Quel complexe se forme lors du test caractéristique du fer.  
 
4. Que se passe-t-il lors de la cémentation ?    
 
5. Calculer le rendement total d’extraction du zinc.   
   
 
Données 
Diagrammes E-pH superposés du Zinc et du Fer 
 

 
 

12345/23
& � 0,34 V 89. ENH ; 1;<45/;<

& � � 0,76 V 89. ENH 

MZn = 65,4 g.mol-1 
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III- UTILISATION DE LOGICIELS 

III.A  Cristallographie 

L’étude sera faite à l’aide du logiciel chimgéné. 

III.A.1  Limites 

• Le modèle du cristal parfait est un modèle : en réalité, il existe de nombreux types de défauts 
(1D, 2D, 3D) qui viennent rompre la périodicité du cristal.  

• De plus, la modélisation en classe préparatoire repose sur le modèle des sphères dures : en 
pratique, il y a un mélange des différents types de liaisons qui peut rendre difficile la 
définition d’un rayon atomique. Cela peut expliquer les différences constatées entre 
structure microscopique et observations macroscopiques. 

Un cristal parfait correspond à un assemblage tridimensionnel d’une maille qui peut avoir 
différentes formes mais est toujours basée sur un objet à faces parallèlépipédiques. 

 
Il existe au total 7 manières de paver l’espace, et 4 types de réseaux. L’ensemble des possibilités 

correspond à ce que l’on appelle les réseaux de Bravais, qui sont au nombre de 14. 

 

III.A.2  Protocole 

Étude de la maille CFC 

La maille CFC correspond à un maillage de compacité maximale dans lequel il y a trois types 
d’empilements de plans. 

Maille 

• Ouvrir Chimgéné et aller dans « Simulation > Cristallographie »  

• Ensuite, cliquer sur « Collection » puis [00] Réseaux de Bravais > Modèle cubique faces 
centrées  

• Choisir 1 translation selon x, y et z.  

• Observer les tangences entre atomes et en déduire une relation entre le paramêtre de maille 
(a = b = c) et le rayon des atomes (a√2 � 4?�. 

  

 
Figure 3 : À gauche, tangence des atomes selon une des faces du cube, à droite, plan d’empilement. 

• Vérifier cette relation en allant dans « Simulation > Cristallographie » puis « Simulation 
étudiée ». Dans l’onglet « Réseau », il y a la valeur de a et dans l’onglet « Motif » la valeur du 
rayon correspondant.  

Empilement 

• Pour visualiser les empilements d’atomes, tracer 2 mailles dans toutes les directions 
(translation selon x, y et z)  

• Tracer puis cliquer sur « Options » en haut à droite  

• Choisir @ + A + B � 2 « Isoler » et validez. Cela permet de voir un plan complet (Figure 3). 

On peut alors voir que dans le plan, chacun des atomes est entouré de 6 voisins.  

• Il est aussi possible de choisir « Étêter » pour tracer ce plan et ceux qui sont au dessus, 
l’option «Colorier» pour @ + A + B � 1 et @ + A + B � 0 permet de mieux matérialiser 
les différents types de plan. On peut alors voir que l’atome violet ne se superpose à aucun 
des atomes bleus.  

 
Figure 4 : Les trois types de plans de l’empilement compact de type CFC. À droite, le rayon des sphères a été 
réduit (clic droit en dehors de la maille Affichage > Rayons représentés à > 75 %) et le contour de la maille 
a été enlevé (Clic droit > Affichage > Contour de la maille > non représenté).  

Coordinence, compacité, masse volumique 

• Pour voir la coordinence, il est possible de faire un clic droit sur un atome au centre des 
atomes représentés > Voisins de l’atome  

• Dans la fenêtre qui apparaît, il est alors possible de cocher tous les atomes plus proches 
voisins (70,7 pm) et décocher tous les autres (Figure 5).  

  

 
Figure 5 : Coordinence d’un atome dans la maille CFC. On peut voir que les groupes de 3 atomes au 
dessus et au dessous du plan sont tournés de 60° l’un par rapport à l’autre. 

• Pour la compacité, il est possible de calculer la valeur théorique et la comparer à la valeur 
donnée par le logiciel (Simulation, cristallographie, Simulation étudiée > Compacité)  

• Il est maintenant possible d’ouvrir une structure réelle (Simulation > cristallographie > 
Collection > 02 Cubique face centré > Fer (gamma) )  
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• Sur cette structure, on peut calculer la masse volumique théorique et la comparer à la masse 
volumique du cristal réel. (au passage, noter la valeur de la compacité qui n’est pas égale à 
la valeur théorique).  

•  Il est possible d’avoir une structure cfc non compacte : Ouvrir le "modèle carboglace" pour 
voir que la compacité n’est alors que de 4 % !  

Sites octa et tétraédriques 

• Revenir à la maille idéale et cocher « Affichage des sites tétraédriques » ;  

• Faire un clic droit : Sites > Montrer un site tétraédrique puis Sites > Tracer et activer les 
différentes option pour matérialiser le site  

  

 
Figure 6 : Représentation d’un site tétraédrique et projection dans le plan de la grande diagonale du cube 
( @ + A � 1 ), le rayon des sphères a été réduit (clic droit en dehors de la maille Affichage > Rayons 
représentés à > 75 %). 

• Il est alors possible de retrouver la taille d’un site tétraédrique avec la condition 

correspondante : √C

#
� ?D + ? 

• La même opération pour les sites octaédrique permet de trouver 2 �?E + ?� � F 

  

 
Figure 7 : Représentation d’un site octaédrique et projection dans le plan d’une face (@ � 0 ou @ � 1/2). 

• Il est alors possible de regarder où peut se mettre un atome de carbone dans le réseau pour 
faire de la fonte (base d’un acier).  

Autres systèmes 

Il est possible de regarder la maille du fer α pour laquelle les sites tétraédriques et octaèdriques 
sont déformés.  

  

 
Figure 8 : Sites interstitiels pour une maille cubique centrée. 

On peut également prendre des structures plus complexes (carboglace, alliage, cristal ionique) 
pour voir les tangences et structures. 

Une autre possibilité est de montrer les positions d’insertion d’un atome de carbone pour faire 
des alliages (acier). Comparer le fer α (cubique centré) et le fer γ (cubique face centré), regarder 
une maille hexagonale qui correspond à un empilement compact avec seulement deux types de 
plans (le graphite en est dérivé mais est une structure non compacte). 

III.A.3 Disponibilité du logiciel  

Le logiciel chimigéné est gratuit et disponible ici : 
https://www.chimsoft.com/chimsoft/chimgene/telecharger-chimgene   
Cependant, il est possible de l’installer que sur des versions antérieurs à windows 10. Il n’y a pas 
d’équivalents qui permettent des visualiser de manières aussi pédagogiques les mailles et 
empilement. Vous pouvez trouver au cas par cas des animations sur internet. Sinon vous pouvez 
utiliser le logiciel vesta (gratuit également) qui vous permet de construire des mailles (je vous 
conseil alors de vous construire votre base de données). Un tutoriel est disponible en ligne 
(http://eduterre.ens-lyon.fr/thematiques/mineraux-et-ressources-minerales/vesta/tutoriel-
dutilisation-de-vesta). Avec ce logiciel les visualisations des sites interstitiels et des empilement 
sont plus délicates. Vous pouvez également télecharger des structures réelles et les ouvrir sur 
Vesta. Il faut alors télecharger des fichiers en .cif, vous pouvez en trouver sur materials project 
(nécessite un compte donc il faut les télecharger avant le jour J) : https://materialsproject.org    

III.B  Dosages : utilisation de dozzzaqueux et Chimgéné 

III.B.1  Dozzaqueux 

Le logiciel http://jeanmarie.biansan.free.fr/dozzzaqueux.html dozzzaqueux est gratuit et 
multiplateforme. 

III.B.2  Protocole 

• Ouvrir le logiciel ;  

• Dans bécher, changer le volume pour 100 mL, cliquer sur rechercher une espèce (par 
identifiant ou synonyme) > "aspartique" cliquer sur acide aspartique introduire 0.135 g; 
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 Attention, le logiciel travaille en concentration, donc si vous changez le volume, il faut 
mieux supprimer et recommencer car la concentration n’aura pas changé.  

• Passer à burette, changer le volume maximal pour 25 mL;  

• Ajouter de la soude (par formule brute > NaOH) dire que la soude sera à 0,1 mol. L�� ;  

• Valider et passer au recensement, ici, il faut faire attention à ne pas trop prendre d’espèce 
(Na2O par exemple)  

• Valider et passer aux constantes de réaction. Il est alors possible d’avoir quelques valeurs 
thermodynamiques intéressantes ;  

• Valider et lancer les calculs ;  

• Choisir les courbes à tracer ;  

• Définir la grandeur en abscisse : choisir le volume V ;  

• Ajouter une grandeur en ordonnée : pH, joindre les points ;  

• Ajouter une grandeur en ordonnée : concentration proton et toutes les espèces dérivées de 
l’acide aspartique, pour ces espèces, choisir « échelle droite »  

• Il est ensuite possible de faire un export en png pour obtenir le résultat suivant.  

  

 
Figure 9: Dosage d’une solution d’acide aspartique par une solution de soude 

Maintenant,simulez le titrage d’une solution de chlorure de sodium à 0,1 M par une solution de 
nitrate d’argent 0,05 M suivi par conductimétrie et potentiométrie (référence ECS).  

  

 
Figure 10 : Résultat avec la conductivité corrigée ou non et le potentiel mesuré à l’aide d’une électrode au 
calomel saturé. 

III.B.3  Chimgéné 

Sur le logiciel chimgéné : Simulation > Chimie des solutions > Dosage. Il existe une base de titrages 
déjà prêts (fer/permanganate, acide phosphorique, chlorure et iodures par l’argent). Par exemple 
pour l’exemple du dosage du mélange d’ions chlorure et iodure. 

 
Pour superposer les courbes de répartition au dosage :  

• Passer en mode graphique (en haut à droite).  

• Aller dans Graphe 2D > Options > Axe YY  

• Cocher Données particulières sur l’axe vertical secondaire > Choix de l’ordonnée > 
Pourcentages > Cocher les anions  

• Puis Graphe 2D > Options > Légendes du graphe ;  

• Pour tracer la conductivité au lieu du logarithme de la concentration en ion argent 
(potentiométrie) il faut aller dans Graphe 2D > Options > Axe Y > Conductivité > corrigée + 
non corrigée 

 
Figure 11 :Exemple de tracé d’un dosage d’ions chlorure et iodure avec Chimgéné. 

Au passage, il est aussi possible d’accéder aux différentes grandeurs thermodynamiques dans 
Simulation étudiée puis « Constantes d’équilibre » ce qui peut parfois être pratique pour retrouver 
une donnée thermodynamique. 

Il est aussi possible d’avoir des courbes de solubilité dans les courbes par répartition en 
utilisant Simulation étudiée > Précipitation > Axe en pH > Tracer Al3+ > Choisir log (s) > Tracer. 

  

 
Figure 12: Logarithme de la solubilité d’une solution d’ion aluminium en fonction du pH. 

III.B.4  Le mot de la fin 

Chaque logiciel a ses avantages et ses inconvénients (pas de potentiel directement avec 
dozzzaqueux, utilisation moins intuitive mais quelques fonctions utiles, graphiques moins 
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esthétiques et paramètrables, base de donnée plus limitée sous chimgéné). Bref, si vous voulez 
vous servir de l’un ou de l’autre, il faut essayer. 

III.C  Tracé d’un diagramme potentiel-pH 

III.C.1  Chimgéné 

 

Toujours avec .. Chimgéné. Il faut aller dans  

• Simulation > Chimie des solutions > Potentiel-pH ;  

• Simulation étudiée > Ajouter un système redox > Fer > Prendre une concentration atomique 
voulue > Ajouter le système > Valider > Tracer  

 

Figure 13 : Deux diagrammes pour le fer avec une concentration de tracÃ© diffÃ©rente. 

Il est possible de déplacer les légendes en mode vectoriel, choisir la convention de tracé ou la 
pente dans « Options de calcul », avoir l’équation des droites dans « Résultats » et avoir le 
diagramme avant ou après dismutation. De même, on peut superposer différents diagrammes 
potentiel-pH pour les combiner entre eux. Il est toujours possible d’avoir accès à certaines données 
thermodynamique dans l’onglet Simulation étudiée. 

III.C.2  Alternatives 
Vous pouvez utiliser Materials Project (https://materialsproject.org) pour générer des 
diagrammes E-pH en fonction de la concentration de travail. Vous aurez besoin d’un compte donc 
il faudra créer votre base de données avant les oraux. Pour créer un diagramme E-pH, il faut choisir 
l’option Pourbaix dans la barre de menu du haut (Figure 14) et choisir l’élément voulu. Les couples 
de l’eau sont automatiquement ajoutés en pointillés.  

 

Figure 14 : Choix du menu sur le site materials project pour tracer des diagrammes E-pH. 

 

III.D  Traitement d’incertitudes : Utilisation du logiciel GUM-MC 
Vous pouvez trouver le logiciel sur http://jeanmarie.biansan.free.fr/gum_mc.html  
 
Le logiciel vous permet de combiner des incertitudes de type B (sur des mesures uniques) ou de 
type A (sur des mesures répetées).  
 
L’utilisation du logiciel est assez intuitive, il suffit de suivre les consignes étape par étape.  
 
Après avoir exprimé l’expression de la valeur calculée vous aurez à donner les incertitudes sur les 
grandeurs d’entrée.  
 
Par exemple, considérant une relation de titrage simple : 
 

CGHGIJ � C� ∗
VJL

VGHGIJ
 

 
On considère que la solution titrante est une solution commerciale à 1,0 mol.L-1 et que sa 
concentration est connue sans incertitude. Le volume de fin de titrage est obtenu en réalisant 5 
fois le titrage, on obtient les valeurs résumées dans le tableau ci-dessous. Pour le volume prélevé 
VGHGIJ � 10,0 mL on considerera une distribution triangulaire avec intervalle type de 0,1 mL. 
 

Exp n° VGHGIJ (en 
mL) 

1 9,5 
2 9,6 
3 9,4 
4 9,6 
5 9,6 

 
La force du logiciel est dans l’étape suivante, en effet on peut alors visualiser la contribution des 
différentes sources d’incertitudes (Figure 15) ce qui vous permet de discuter de l’optimisation 
éventuelle du protocole.  
 

 

Figure 15 : Visualisation de la contribution des différentes incertitudes sur le resultat 

Dans l’onglet intervalle de confiance vous pouvez visualiser le résultat présenté en fonction des 
différents taux de confiance.  


